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APPLYING FLATCAM FOR PCB CNC MILLING 

FlatCAM takes standard data files from PCB design software packages and converts them into CNC 

milling and drilling GCodes that can be run on a CNC milling machine.  The PCB design can be single 

or double sided. FlatCAM provides the tooling setup to align double sided designs.   FlatCAM also 

provides the board outline profiling GCode and the coding for any cut outs needed within the board 

area. 

FlatCAM up to version 8.5 was created by Juan Pablo Caram but subsequent updates are supported 

by Marius Stanciu.  At the time of this write up the current issue level was 8.991.  The original 

documentation by Juan Pablo Caram describing the application of FlatCAM is to a reasonable 

standard but not always intuitive. This write up is an attempt to clear the mists and is based around 

version 8.5 which is more than adequate for most PCB milling needs.  The later versions are 

somewhat more complicated but do have features that more advanced users might require. 

Overview 

This write up will cover the production of double sided boards and includes details of experiences 

regarding work holding and also milling tool selections.  Single sided board are much less complex to 

produce using a cut down version of these details. 

FlatCAM needs Gerber files of the top and bottom copper trackwork (.gbr) and Excellon drilling 

information (.drl).  These are industry standard format files for PCB manufacture and any PCB design 

software will allow export of Gerber and Excellon information.  Both these files types have their data 

stored in ASCII format and a CNC machine requires GCode.  FlatCAM provides a conversion process 

between these two formats. The process is not a single click on a button. The Gerber files (.gbr) first 

get converted to an ISO file, then the ISO becomes a CNC ready file before the CNC file is converted 

to GCode.  The Drill file (.drl) follows a similar process. 

Board Side Naming and Mirroring 

At this stage of the write up it is worth taking time to consider the logistics of the milling process 

that impact on the Gerber data. 

PCB design software has traditionally created the PCB artwork ‘looking down through’ the board 

when viewed from component side.   This is a historic method when components had ‘legs’ that 

passed through the board material to be soldered to the copper traces on the lower side.   As 

technology has progressed boards became populated on both sides and now with surface mount 

devices there is little to choose as to which is ‘component side’ and which is ‘track side’.   This will be 

defined by the designer who will be focussed on such things as connectors which generally will be on 

component or top side.  This is a good reason to now refer to the two sides as ‘top copper’ and 

‘bottom copper’ rather than component related and this is the term used by FlatCAM and will be 

used going forward in this write up. 

The other aspect to consider is that the bottom copper artwork is as viewed in the design process 

down through the board from top side.   If the bottom side gerber file was used as a basis of the 

milling code the machine instructions will be incorrect.   The bottom copper instructions must be 

based on ‘looking at’ the copper artwork from the bottom side not down through from the top side.   

To correct this the bottom copper artwork must be converted to a mirror image.   This can be done 

in the PCB design package but FlatCAM does this for you. 
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Double Sided Milling Process 

Let us assume the following simple work flow : - 

The PCB material is clamped on the milling table.    

The top side artwork is milled. 

Any through holes are drilled. 

(Potentially the PCB profile is half depth milled) 

The PCB material is turned over and the bottom side artwork is milled. 

The PCB is profiled with breakout tabs and then broken free from the parent blank material. 

The success of this process is the ability when turning the PCB parent material over to mill the 

bottom side that it aligns correctly with previously milled top side.  To do this requires the use of 

tooling pins that will locate the board in sync for both top copper and bottom copper processes. 

FlatCAM has a function to aid this where it produces a CNC GCode that allows tooling holes to be 

positioned to align the two sides.   The process steps as listed above will therefore have an added 

step to do this.   After clamping the material to the milling table the first process will be to drill the 

tooling holes.    

The GCode for the tooling holes is created in FlatCAM.  Providing nothing is accidentally changed on 

the mill reference, these tooling holes will allow the board to be flipped from one side to the other 

and maintain top and bottom artwork alignment.  (Clearly for single sided boards this is not 

relevant). 

You can position the tooling holes where you wish but some thought is needed about the mirroring 

process. 

To mirror an object you need an axis about which to mirror it.  In CNC terms this could be about the 

X or Y axis.   Where you position this axis or mirror line is important.  If you chose to use the left 

hand vertical edge of the top copper artwork (Y axis) then the bottom side copper will ‘hinge’ on this 

edge like a page in a book and be placed immediately to the left of the top copper. This means the 

PCB blank material would have to be physically moved across on the milling table before work on 

the bottom side could commence.   If you make the mirror line exactly down the centre of the PCB 

artwork then the PCB blank will not move its position as you turn it over to mill the bottom copper.  

Once you have chosen your mirror axis the tooling pins will make sure the alignment is correct and 

repeatable. 

To create the tooling hole drill code you specify where you would like the tooling hole(s) to be 

located based on the top side view and your chosen mirror axis.  When you mirror the bottom side 

copper you don’t just get the copper mirrored but you will also get a mirrored position of the tooling 

hole – one chosen position creates a mirrored second.  The location of the second hole is created in 

FlatCAM based on the mirror line that you have specified.   The mirror axis can be specified as an 

extrapolated line from a point or based on a box (generally this will be the periphery outline of the 

PCB).  In my experience you need to specify 2 tooling holes for FlatCAM to create 2 further ones as 

mirror locations.  Having two (leading to four) keeps the board more rigidly held. 

That might take a little getting your head round.   See the following images.  The first image 

represents the parent material with the PCB layout central on the blank.   A single tooling hole has 

been placed and a Y axis mirror line has been arbitrarily decided on. 
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You can simulate this.  

Take two pieces of A4 or similar paper which will represent the parent blank PCB material.  Draw a 

rectangle on the first piece of paper to represent the PCB artwork outline.  Draw a single circle to 

represent the tooling hole somewhere outside the PCB artwork area.   Draw a dotted line on the 

artwork to represent the mirror axis.   Make a photocopy of this onto the second piece of paper.   

Superimpose the two pieces of paper so that they represent the top side as viewed and the bottom 

side turned over.   Align the rectangles so they both sit on the mirror axis line and otherwise match.  

Unless you made the mirror axis sit exactly mid way on the rectangle you will find that the two 

sheets of paper must be offset for the tooling holes to align with each other. 

 

The next image is the mirrored image representing the Bottom Side as viewed from the bottom 

rather than down through the PCB layout from the Top Side.  This is the view that the milling 

machine needs to mill the Bottom Side artwork. 

 

The next image shows how the tooling hole is mirrored about the mirror axis.   The two tooling holes 

will be drilled from the Tooling drill file created by FlatCAM.   In order for the PCB parent to locate 

onto the two tooling pins the PCB will have to be offset between Top Side and Bottom Side activity 

as shown. 
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If the mirror axis is exactly central on the PCB outline the problem goes away. 

 

 

 

Why is this important ? 

Suppose you have a fixed frame tooling jig to clamp the parent material down.   When you try to mill 

the bottom side you will have to move the frame to match the movement in the parent material 

relative to the tooling holes.  This is a recipe for an alignment disaster.  

I suggest that in order to create less hassle it is prudent to make the mirror axis symmetrical either in 

X or Y on the PCB design.   In order to facilitate this it is important to make the centre of the PCB 

artwork design equal to X0,Y0.  This can be done in the PCB design package where you should be 

able to set the PCB design origin point.   

I mentioned earlier that the mirror can be defined in FlatCAM from a Point (X,Y) or can be from a 

Box.   The Point method is already described where you create a 0,0 reference in the centre of your 

PCB design and use this as the Mirror either about X or about Y.   If you use Box, unless the artworks 

for top and bottom have a common geometry outline designed on them, FlatCAM looks at the 

artwork design and decides where it believes the centre point of the artwork is.  This could be 

completely different between top and bottom copper designs.   If you need to use Box then make 

sure you have an identical border on all layers of the PCB design. 
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It is suggested that an arbitrary pad is placed on the artwork on both top or bottom sides that sits on 

the axis mirror line you have chosen.   This should be outside of the formal design area. This pad 

gives you a reference that all is well with the mirroring of the bottom side.  This will hopefully 

become clearer when we move into the process in FlatCAM. 

PCB Design Files Needed 

The file requirements from the PCB design software now breaks down into the following : - 

Board outline (Gerber file *.gbr) 

Top side copper artwork (Gerber file *.gbr) 

Bottom side copper artwork (Gerber file *.gbr) 

Drill file based on top side view (Excellon file *drl) 

(A aperture artwork file for any slots that need milling (Gerber file *.gbr)) 

 

Note that none of these files should be mirrored in the PCB design package export.   This is done 

entirely in FlatCAM. 

Here is a screen shot of the FlatCAM opening screen with the various areas marked. 

Graphic Image Area

XY location

X Axis

Y Axis

Activity Log Window

Process Tabs

 

Navigation 

You can move around the FlatCAM screen using your mouse.    

To zoom in and out of the image area you can rotate the mouse wheel.   The image will enlarge or 

shrink centred on the current mouse cursor position on the PCB image. 

To move the viewing area and re-centre the image press and hold down the scroll wheel and drag 

the image to where suits.  You can also use the Zoom Fit button below the File menu. 

Clicking with the left button anywhere in the drawing area will automatically transfer the X and Y co-

ordinate values of that point to the computer clipboard.  This is important to note. 

You can minimise the lower ‘activity’ section to give you a larger board viewing area. 
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Stage – 1 Importing Data 

Before importing data make sure that the units of measure match between the PCB design data and 

FlatCAM.   If not change this in the tick box at the top of the Options tab. 

 

Create a folder on your computer and store the exported Gerber and Excellon files from the PCB 

design.  For the purposes of this write up these will be called TOP.gbr, BOTTOM.gbr and DRILL.drl. As 

you read further you will realise that there is an advantage in also importing a BORDER.gbr file 

having just the geometry of the border outline of the finished PCB.  The board artwork should be 

designed and referenced centrally as X0,Y0.  I repeat - the files exported from the design software 

should not be mirrored in anyway. 

Load the files using the FILE dropdown menu to bring in the two GERBER and one EXCELLON file.   

Note that you have to select the Gerber files separately to import them but in more recent issues of 

FlatCAM you can select multiple files of the same type at once.  Note that once you have all the files 

imported you can save them as a Project within FlatCAM. 

If you now click on the Projects tab you will see the files you have chosen are listed and they will also 

be visible in the graphic area. 

I have created a simple board to highlight some of the issues and you will see that I have also 

imported a file called BORDER which is just the outline of the PCB.  More about this later. 

 

 

Stage 2 – (Option) Resetting the Reference 
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If you have a design where the Gerber files you have imported are not referenced to X0Y0 then you 

need to change this.   If you don’t do this the CNC code will have a large movement of the spindle 

from its reference position to the working area of the milling of the board.   This could be outside of 

the milling envelope which is a problem and potentially a tool crash.  This problem also has 

implications for the double sided board mirroring process. 

Follow this sequence : - 

1 Go to File/New to clear any existing data and then File /Open and navigate to the folder 

where you have the files for the project stored and select and import all the files.   The 

file images will now appear stacked on each other in the Graphic area and will be listed 

in the Project tab listing area. 

2 Click on the BOTTOM.gbr file in the Project tab to make it the file of interest. Check the 

co-ordinates of the lower left corner of BOTTOM.gbr artwork.  You can read this from 

the X and Y scales on the FlatCAM viewing window edge or you can hover the mouse 

over the artwork bottom corner and you will see the precise co-ordinates shown in the 

very bottom edge of the FlatCAM window. 

3 If the co-ordinates for the bottom left corner of the artwork are not anywhere close to 

X0Y0 then click on the bottom left corner of the artwork with your mouse.   This will 

transfer the values for X and Y at the point you have clicked to the clipboard in the 

computer. 

4 Click on Selected and look at the Gerber Object window and slide the slide bar down to 

the bottom until you see the Offset section.  Swipe with the mouse to highlight the 

(0.0,0.0) default data and press CTRL+V.   This will copy the X and Y values of the bottom 

corner of your BOTTOM.gbr artwork into the Vector box.   Now you must edit these 

values to reflect the movement you need to make.   Generally this will be to make the 

values show negative values by typing a minus sign (-) in front of each value.  Once this is 

done copy the new minus values to the clipboard using CTRL+C.   (This makes things a 

little more slick when you bring in the other artworks and ensures they move the same 

amount in X and Y).   If all looks good click on the Offset button. 

5 Your BOTTOM.gbr artwork will have disappeared from the Graphic window but if you 

move the window to centre on X0Y0 you will find the BORDER.gbr artwork is now 

located much nearer X0Y0. 

6 Repeat this process for the TOP.gbr and DRILL.drl Excellon and save time by using 

CTRL+V to copy your negative movements into the Offset vector window.   If you do not 

copy from the clipboard there is a danger of having different negative moves and the 

artworks will no longer be correctly stacked one on top of each other. Note that the 

Excellon dialogue window is slightly different but there is still an Offset vector section at 

the end of the settings section. 

7 You should now have all three artworks located on or near X0Y0 and correctly aligned on 

top of each other. 

Stage 3 - Mirroring the BOTTOM.gbr file 

As mentioned earlier, the three images of TOP, BOTTOM and DRILL should now be shown in the 

viewing window and should be superimposed on each other and synchronously positioned.   The 

data for BOTTOM.gbr is as viewed down through the PCB when looking from the top of the board 

and this needs to be reversed (mirrored).  Without this process the GCode file for the milling process 

will be the opposite of what it should be.  It is important to mirror BOTTOM.gbr before you continue. 

Click on Tool on the top menu strip (not the Tool tab) and select Double Sided PCB Tool.  This will 

now take you to the Tool tab where the mirroring and tool functions are selected. 
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The first selection is to pick the artwork that is to be mirrored.  Usually this will be the BOTTOM.gbr 

artwork. 

Next is the Mirror axis selection and as described earlier this can be done about the X axis or the Y 

axis.   A mirror on the X axis will flip the layout vertically and a Y axis mirror will flip the layout 

horizontally. 

You must now choose where you want the mirror line to sit on the artwork.  Providing the artworks 

as created in the PCB design package are centred on X0,Y0 select Point and enter 0,0 as the Mirror 

point. 

If you choose Box as the mirror basis then you are asked which artwork you want the BOTTOM 

copper to be mirrored against.  This might be the TOP copper but only do this where there is a 

border around the artwork that matches a border on the BOTTOM copper otherwise the artworks 

will be offset.   Without the border information FlatCAM makes its own mind up what are the 

boundaries of the artwork and hence a non central 0,0 location. The other option is to import the 

extra Gerber file that just has the PCB outline and use this as the mirror reference.  I have imported 

this as BORDER.gbr. 

Stage 4 - Tooling Pins 

Assuming you have created and entered the mirror axis by Point or Box you now must enter one or 

two positions for tooling pins to hold the PCB in the correct place for BOTTOM and TOP milling.   

These can by anywhere around the PCB but outside of the areas to be milled.  When marking these 

positions keep in mind the working area of the milling spindle and ensure that the tooling holes are 

well out of the way to avoid a crash. As with other processes you can click on the position you want 

to use and then copy the value into the Alignment Hole box or manually write the values in the box.  

Think about the mirror position implications when choosing the locations.   

Do this twice so each X and Y is bracketed and the two values are separated by a comma and you put 

a decimal point in each value [(Xa.a,Ya.a),(Xb.b,Yb.b)].  You can edit your copied values if you wish to 

make them rounded figures. 



Woody’s Workshop  www.altrish.co.uk 

PCB Milling with FlatCAM Page 9 of 21 March 2020 

Once you have your two chosen locations entered, enter a value for the tooling pin hole diameter 

and press the Mirror Object and Create Alignment Drill.  If the mirror is symmetrical you will now see 

four circles on the display representing the tooling pins (the two you entered and the mirrors of 

these) and these will be symmetrical about the PCB mirror line you have chosen (X or Y).   If the 

mirror axis is not symmetrical on the board geometry then the four tooling holes will be 

asymmetrically placed. 

Here is a before and after view of the two actions. 

 

 

 

 

If you check the Project listing you will now have an added file called Alignment Drills.  If you decide 

you want to change the locations of the tooling pins you can go to the Project tab and delete the 

Alignment Drills file and re-do the positions.   Do not re-mirror the object or the BOTTOM.gbr will be 

no longer correct. 
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Stage 5 – Gerber Object Dialogue 

You may have already used the lower area of the Gerber Object window to move the artworks to 

X0Y0 using the Offset Vector section.  For this simple introduction we will ignore Non Copper 

Regions and Scale sections.  We will focus instead just on Isolation Routing and later on we will use 

the Boundary Box section. 

1 Go to the Project tab and select TOP.gbr and then the Selected tab to see the Gerber 

Object working area. 

 

 
 

2 Leave the Plot and Solid tick boxes ticked and Multicolour unticked. (Note that Colour 

gives an outline of the traces but Solid has to be unticked for this to work).  You can 

check that the correct file has been chosen by toggling the Plot tick box. 

3 Enter the milling tool diameter you will use to cut the copper in Tool Dia.  Take care that 

you use the same measurement standard as the artwork. 

4 The Width box is slightly confusing.   You enter here the number of times you want to 

mill around the artwork geometry to create the wanted cutting gap around the tracks.   

If you have a 5 thou tool tip and you want a 10 thou gap you would enter 2 to make the 

mill pass twice around the geometry.    

5 Pass Overlap is the percentage value of overlap you want between each cut of the tool.  

A value of 1 indicates 100% overlap and a value of 0 means no overlap.   If you have 

chosen 1 for your Width value then the Pass Overlap will be ignored. 

6 Click on the Generate Geometry button. 

7 You will now see a red border around the tracks that represents the tool movement.  If 

you have chosen a value of Width of more than 1 than there will be a matching number 

of borders shown.  If you have chosen a value of Pass Overlap other than 0 then the 

outer border will appear wider to indicate the amount of overlap you have selected. 

8 Go back to the Project tab and.  You will notice in the Project tab that there is now a file 

called TOP.gbr_iso which is the processed file you have just completed.   Select 

BOTTOM.gbr and repeat this process to get the ISO version. 

9 If you have other Gerber files repeat this process until all files have matching ISOs and 

the associated artworks have red outlines. 
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10 Go back to the Project tab and select the TOP.gbr_iso and then go to Selected where you 

will see a Geometry Object window. 

11 At the top of the Geometry Object window you will see the name of the file you have 

selected.   This should be TOP.gbr_iso. 

 

 
 

12 You should have Plot ticked. 

13 Go to the Create CNC job section and note the following : - 

a. Cut Z – this is the depth of cut from the top side copper through the board by all the 

tools you have chosen to use.  It is always a negative value as it is cutting into the 

PCB material from the top surface which is Z0. 

b. Travel Z – this is the height that the tool tip moves up from the board surface while 

moving rapidly around the board to jump to another cutting position. 

c. Feed rate – this is the rate at which the spindle will move in X and Y while 

performing the milling process. 

d. Tool Diameter – enter the diameter of the milling tool you will be using. 

e. Spindle Speed – this is the spindle speed while cutting or drilling.   I think you must 

enter a value in this box or you will not be able to create the CNC code.  Set this as 

high as your machine will allow. 

f. I have never used Multi-Depth and always left it unticked. 



Woody’s Workshop  www.altrish.co.uk 

PCB Milling with FlatCAM Page 12 of 21 March 2020 

14 Click on Generate – the earlier tool paths will now have turned blue to show the CNC 

tool movements. 

 

 
 

15 There will now be a TOP.gbr_iso_cnc file in the Project tab listing. 

16 Repeat this process for all the other ISO files. 

17 When all ISO_CNC files are ready go back to the Project tab and select the TOP.gbr_cnc 

file. 

18 Go to the Selected tab and you will see a window for the CNC Job Object.   The file name 

should match in the top box. 

 

 
 

19 Plot should be ticked and you should check that the tool diameter matches your 

expected milling size.  If incorrect, edit the diameter and click on Update Plot. 

20 The next two boxes allow you to add GCode commands to the start (Prepend) and finish 

(Append) of the GCode that is going to be created.   These are usually machine specific 

start and end commands and will depend on your machine requirements.  Details of 

these settings are given later in the text. 

21 Tick the Dwell command and leave at 1 second.  This defines how long the program sits 

waiting before running.  This gives you a bit of breathing space to hit the big red button. 

22 Click on Export G-Code and name the resulting file before saving ready for loading into 

your milling machine. I suggest you give the file a .nc extension name, 

23 Repeat this process for all other .gbr_iso files. 
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Stage 6 -  Excellon Object Window 

The process of the .drl files is slightly different. 

1 Go to Project and click on the DRILL.drl file.  Go to the Selected tab.  The Selected tab is 

now different being an Excellon Object window.  At the top of the Excellon Object 

window you will see the file name.   If this isn’t DRILL.drl go back to Project and select it 

so it appears in the window. 

2 You should have Plot ticked and Solid ticked only if you want to see a red dot 

representing the holes. 

3 In the Tools window you will have a listing of the tools that have been defined in the 

DRILL.drl file for use drilling the holes on the PCB.  Click on the # symbol to include all 

tools or select the ones you only want to be included for this CNC activity. 

4 Go to the Create CNC job section and note the following : - 

a. Cut Z – this is the depth of cut from the top side copper through the board by all the 

drills you have chosen to use.  It is always a negative value as it is cutting into the 

PCB material from its top surface. 

b. Travel Z – this is the height that the tool tip moves up to while moving rapidly 

around the board to jump to another drilling position. 

c. Feed rate – this is the rate at which the spindle will move while performing the 

drilling process. 

d. Tool Change – untick this for now.   It is the height that the spindle must move to so 

you can access the collet to change a tool in mid process. 

e. Spindle Speed – this is the spindle speed while drilling.   I think you must enter a 

value in this box or you will not be able to create the CNC code.  Choose the fastest 

speed your machine can handle. 

5 Click on Generate 

6 You will now see the pattern of the spindle movement and the order in which holes will 

be drilled and a new file will appear in the Project window – DRILL.drl_cnc. 

7 Select the DRILL.drl_cnc file and go to the Selected tab and you will see a window for the 

CNC Job Object the same as the you had for the Gerber files. 

8 Plot should be ticked and you should check that the tool diameter matches your 

expected size and if you edit this click on Update Plot. 

9 The next two boxes allow you to add GCode commands to the start (Prepend) and finish 

(Append) of the GCode that is going to be created.   These are usually machine specific 

start and end commands and will depend on your machine requirements.  Details of 

these settings are given later in the text. 

10 Tick the Dwell command and leave at 1 second.  This defines how long the program sits 

waiting before running.  This gives you a bit of breathing space to hit the big red button. 

11 Click on Export G-Code and name the resulting file before saving ready for loading into 

your milling machine.  I suggest you give the file a .nc extension name. 

12 Repeat this process for the Alignment Drills file but the depth of cut now needs to be the 

thickness of the PCB material plus (say) 80% of the thickness of the sacrificial material. 
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Stage 7 - Board Outline 

There is a facility within FlatCAM to mill the board profile and leave breakout tabs.  This requires a 

Gerber file that has the outline of the board contained in it.   Alternatively this can be a standalone 

Gerber that just has the outline geometry.  For this example there is a file called BORDER.gbr. 

1 In project select BORDER.gbr and then click on the Selected tab. 

2 You will see the following extract from the Gerber Object details.  Go straight to the 

Board Cutout section and enter the tool diameter that will route the outside boarder. 

 

 
 

3 The Margin box allows a gap between the PCB outer edge geometry and the router path. 

4 Gap Size is the width of the tabs that will be left by the routing. 

5 Gaps allows selection of how many tabs to a maximum of four.   If only two tabs are 

chosen then you have the choice of on which axis these will be. 

6 On completion of these four sections you can Generate Geometry to create the 

BORDER.gbr_cutout file.  You will see four profile lines appear on the layout to represent 

the cut geometry. 

7 The process now follows as for the other files.   Select the BORDER.gbr_cutout in Project 

and then go to the Selected tab to set the Geometry Object. 
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8 In the Create CNC job you will have to change the Cut Z to reflect the depth of cut and 

also change the tool diameter to reflect this process.   (Note that it sometimes 

convenient to half cut through the board while working on the TOP copper and then 

finish it off on as part of the BOTTOM side activity.   This means the board is more rigid 

until all the processes are complete and the final action is to repeat the half depth cut to 

leave just the tabs).  After making these changes click on Generate. 

 

 
 

9 There will now be a BORDER.gbr_cutout_cnc file in the Project window. 

10 Select this file and the final step is to Export the GCode. 

 

Process Summary 

This write up is long but I hope you will see that the process boils down to having the raw files from 

your PCB design package and following repeat steps. 

a) Import the Gerber(s) and Excellon file(s) from the PCB design package. 

b) Add the Tooling hole(s). 

c) Mirror the BOTTOM side. 

d) Create ISO files of each Project file 

e) Create ISO_CNC files of each Project file 

f) Create a GCode output file for each Project file. 

If you are not happy with a file for any reason then go to the Project tab and delete it and re-run the 

processes associated.   The one exception is the mirror of BOTTOM which should be done just once.  

The problem with the mirror action is that the BOTTOM file does not get re-named in any way to 

give you confidence that it has been done and saved.  If you doubt it in any way then delete it from 

the Project list and re-import from your PCB design package. 
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Milling the Board 

The following notes assume that the board is double sided, you have a symmetrical mirror on the 

BOTTOM file and you have at least one tooling hole that has been mirrored with the BORDER file. 

1 In order to protect the milling table you must first clamp a piece of sacrificial material to 

the milling table.   10mm or 15mm MDF makes a good material for this as MDF tends to 

be quite uniformly flat. 

2 Take the PCB blank you intend to process and mark on it the two diagonal lines to find a 

central position.  Fix the PCB blank in place on the sacrificial board so that the milling 

machine spindle is at X0,Y0 it is sat over the centre of the PCB material centre position. 

Clamp the PCB material in place.  This can be hard clamping or could just be using 

masking tape so long as you are confident it can’t move. 

3 Zero the mill spindle Z0 at the centre of the PCB blank using a Haimer probe or similar. 

4 Load the Alignment Drills.nc file into the milling machine. 

5 Load the milling tool or drill specified for the tooling hole size and check that the tool 

measures to Z0 when just touching the top surface of the PCB blank. 

6 Check the cut Z reflects the depth of the PCB blank and 80% of the depth of the 

sacrificial material. 

7 Run the Alignment Drills.nc. 

8 This will create the two tooling holes or some other even number of holes depending on 

how many tooling hole positions you have chosen. 

9 Dust off the material and insert tooling pins into the tooling holes.  The PCB is now 

rigidly located on the sacrificial material which in turn is rigidly fastened on the milling 

table.   The PCB will need some extra fastening to make it as flat as possible on the 

sacrificial material.  

10 Load the TOP.nc GCode into the mill and install the chosen milling tool. Check Z0 to the 

top of the PCB blank. Run TOP.nc 

11 Repeat this for the DRILL.nc file with the correct tool loaded and after having checked 

Z0. 

12 When the above operations have been run, carefully lift the PCB blank from the tooling 

pins and turn it over and fit back over the tooling pins and clamp it in place.  If you have 

followed the symmetrical mirroring instructions the PCB blank will sit in the same 

position over the tooling pins. 

13 Run the BORDER.nc GCode file to cut the PCB profile leaving only the breakout tabs.   

Check Z0 and depth of cut in Z before running to ensure you pass completely through 

the board. 

14 This completes the board and it can now be removed from the milling table and broken 

out of the PCB blank reading to use. 
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Default Settings and CNC Edits 

FlatCAM has the ability to save a set of preferred settings.  If you open FlatCAM as a New Project and 

go to Options but without having imported any file to process, you can fix and store these settings.  

Here is a view of my settings for a 5 thou tool on 1.55 PCB milled on my Tormach 440 running at 

120mm/minute feed rate. Once you have entered your settings go to File and Save Defaults.  These 

settings will be loaded each time you start a new job.  If you change them during a job the changes 

will only apply to the job being run and not be carried forward. 
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Note that at the bottom of the Options tab are two boxes to allow you to Prepend and Append 

GCode commands to the final GCode created by FlatCAM.    

I have stored my start-up reset commands for the Tormach with G21 indicating that the job will be 

run in metric format.   The G30 and X0Y0 command is a failsafe.   This is because if you leave the 

spindle somewhere off the PCB and start to run a FlatCAM CNC code, the spindle will plunge at that 

location.   This can be expensive.   This prepend code moves the spindle up a high Z set in the mill 

G30 location before moving to 0,0 ready to run.  

Note also that I have entered a comment warning line regarding tool selections.   This is borne of 

lapses of concentration when flipping between drilling and milling and having the wrong tool left in 

place.   It might just save you from an expensive ding.    

The Append G30 simply moves the spindle up and away to the G30 location at the end of the job to 

allow a tool change to take place and to get at the job on the mill table. 

 

Milling Cutters 

You will have your own opinions on what is best to use to cut the PCB geometry.    

V bit cutters are the lowest cost and are readily available from overseas sources.  They can be fragile 

if you are using a narrow tip (5 to 10 thou) with a narrow V angle (10 degrees).  If you choose to use 

a narrow tip with a wide angle (45 degrees for instance) then small variations in board clamping 

flatness will lead to a wider and deeper cut into the PCB copper and substrate.  Depending on the 

artwork this may or may not be a problem.  Appendix A details more on this subject. 

The ideal cutters to use are these with a short parallel section from the cutting edge before the taper 

section commences.  This eliminates width of cut variations but will not improve depth of cut 

changes.  Cutting the PCB substrate material will lead to more wear then cutting copper. 

There are hybrids of both types available and I have found Think and Tinker to have some very good 

tooling for PCB routing. 

Conclusion 

This write up is long and will need a number of readings and experimentation to understand the 

process.  There is repetition in the process which you will soon realise means a simple click to accept 

action as you go through the various stages and you will get quicker as a result. 

My colleague and I have spent many hours fine tuning the FlatCAM process and we are now able to 

produce repeatable very fine artworks.  Here is a micro USB pad array as an example.  We hope this 

write up helps you achieve the similar results. 
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Appendix A - Clamping the PCB blank and Coolant 

This is an experience download for you to cherry pick what suits you best.  There are various 

methods of clamping and the aim of each is to try to clamp the PCB blank as flat as possible on the 

tooling table.  The board needs to be held as flat as possible because any variations in the surface 

height will create a variation in the width of cut and depth of cut into the PCB copper surface and 

underlying substrate.   This is the most critical aspect of the process. Note that single sided PCB 

material is worse than double sided due to the asymmetric stress created by the one sided copper 

lamination process. 

A simple sketch of depth and width variation follows.  The three V tools should be regarded as being 

at the same height and the board bowing up more on each one. 

 

 

 

Edging Strips or Fixed Frames 

After masking tape, edging strips of metal stock are the simplest port of call for holding the PCB 

blank.  The downside is that as these strips clamp the edge they can exert a downward pressure on 

the PCB edge and this in turn leads to an upward bow of the centre of the PCB blank.  This can be 

improved by having foam rubber strips on the edging strips to decouple the clamping action. 

If you have a matrix type tooling plate on your mill table you can have an open frame that matches 

the matrix and this can have foam decoupling also.   With a clamping frame it is essential to make 

sure the mirror is symmetrical or the frame will have to be moved to match the offset.  See the later 

comments on using a vacuum table. 

Floating Foot 

It is possible to buy or make a spring loaded floating foot with ball bearing pressure points.  This sits 

on the spindle and creates downwards pressure on the PCB blank around the area that the tool is 

cutting.  To date I have not tried this method.  Clearly this will need the tooling holes to be much 

wider spaced from the PCB working area to give clearance on the footprint of the floating foot. 

Vacuum Table 

Currently this is my favourite method.  I created an aluminium vacuum table that is driven from a 

domestic vacuum cleaner acting as the suction source.  The table has a 10mm x 10mm matrix of 

6.8mm holes with 1mm pin suction holes at the bottom of each.   It has serious suction and the PCB 

can be seen to jump flat when the vacuum is turned on. 
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My tooling pins have a 6.8mm shank to fit into the vacuum plate matrix holes with 4mm protruding 

top section that engage with the MDF.  Despite what you might think, MDF is very transparent to air 

circulation.   The vacuum will therefore suck the PCB material down onto the vacuum table through 

the MDF.  

I have created a standalone CNC program that is independent of FlatCam that will drill 4 x 4mm 

holes just to the depth of the MDF and centrally within the corner holes in the vacuum table.   The 

location of these holes is referenced to the centre hole in the vacuum plate.    

This referencing needs to be reasonably accurate if the vacuum plate is not going to be damaged 

when drill the MDF tooling holes.  To achieve this I have a ‘mushroom’ that has a 6.8mm shank that 

sits in the vacuum table centre hole and the top cap of the mushroom, which is 25mm diameter, is 

probed in X and Y to find the exact location of the centre hole.  The CNC program drills the four holes 

to a depth of just that of the MDF.   Having completed this the MDF can be located in place on the 

pins.  I use 3mm MDF to ensure as much suction passes through the MDF as possible. 

When creating the PCB tooling hole positions in FlatCAM I ensure that that they are positioned in a 

multiple of 10mm spacing from the central line of symmetry.  I use 4mm tooling pins. This means 

that like the MDF tooling holes I can drill the PCB tooling holes into one of the 6.8mm cavities 

without damaging the tooling plate. The drilling depth of the hole now needs to be the thickness of 

the PCB material plus the MDF thickness.  

The mill will have been referenced to 0,0 to drill the MDF tooling holes and you can now use the 

spindle position to locate the PCB blank centrally on the MDF.   Pencil two diagonals on the PCB 

blank to get a fix for the centre.  Once you have positioned the PCB under the spindle at 0,0, turn on 

the vacuum and drill the tooling holes created in FlatCAM.   If you have everything correctly 

referenced these holes will pass through the PCB, through the MDF and into a vacuum plate cavity 

without doing any damage to the vacuum table. 

With the vacuum still running push the 4mm tooling pins into the PCB and through the MDF.   My 

tooling pins are also mushroom shaped.   As I am only using 3mm MDF there is the potential if just 

using plain 4mm pins for them to sway and not remain vertical with respect to the PCB surface.  This 

would lead to alignment errors between top and bottom artwork milling. By having mushroom 

shaped pins with a top hat section, they can be pushed down flat onto the PCB surface and maintain 

the vertical alignment.  

A word of warning - unless you can absolutely guarantee the accuracy of spindle location at the 

centre hole on the vacuum plate do not try to make the MDF tooling pins rigidly located in the 

vacuum table also act as tooling pins for the PCB.   If the centre hole measurement location is not 
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exactly 0,0 the tooling holes drilled in the MDF will have a matching group offset in X or Y or both.   

The MDF tooling pins are rigidly in the vacuum plate and the MDF will now have to ‘drift’ to fit over 

these.   This does not matter if just the MDF is being located as it is purely a locating and sacrificial 

backing medium.  If you drill the same tooling holes in the PCB and the MDF together and try to use 

the MDF tooling pins for both then because of the drift, the 0,0 centre of the PCB will have moved 

based on the centre hole location referencing error.   Your mirror milling of the bottom artwork will 

now be offset and there will be a wailing and gnashing of teeth.   The PCB tooling holes must be 

independent of the MDF tooling holes when the MDF tooling holes are rigid with respect to the 

mill 0,0 and you cannot guarantee the exact 0,0 location. 

From the aforementioned you will note with independent location of the sacrificial material and PCB 

material, the PCB location accuracy on the MDF now becomes more relaxed.   The limit for this 

relaxation is purely down to how much error can be tolerated before damage occurs to the vacuum 

plate when drilling the 4mm PCB tooling pin holes through the PCB and MDF into the 6.8mm 

cavities. 

 

This problem does not manifest itself if there is no requirement to make the MDF tooling pin 

location fit some pre-defined position on the mill table such as the vacuum hole matrix.  If this is not 

a requirement then simply clamp the MDF in place on the mill where suits, clamp the PCB on top of 

the MDF and then drill blind PCB tooling holes into the MDF surface relative to the PCB centre and 

the mill spindle 0,0.    

As there is no need for vacuum transmission through the MDF, thicker MDF can be used and the 

tooling pins will be held more vertical and PCB have reduced sway when turned over.  Clearly the 

PCB must be held rigidly in place while the tooling holes are drilled.  The downside of this method is 

the concern about how flat the PCB is going to be on MDF without a vacuum suction.  One solution is 

to use a levelling program such as available for Mach3 users. 

 

Coolant 

My Tormach 440 has a FogBuster mist coolant system.   Having this running with a very fine mist 

spray appears to help the milling process.  The coolant must help lubricate the cutting tip.  The 

coolant also dampens dust. The coolant also flows into the cut traces and as a result these appear 

darker during the milling process and are more obvious to inspect as the milling progresses.   Note 

however that the coolant will be absorbed by the MDF and cause it to swell. This will degrade the 

flatness of the MDF so it can only be used for one PCB run before disposal.  An alternative manually 

applied lubricant could be a diluted washing up liquid dabbed on with a paint brush. 


